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Meeting programme
Wednesday 27th July 2016
7:30 Monthly Meeting
• Welcome and News
• Bart Hanson - Lead Glasswork
• Apple’s Apps - continued
• Supper
Come along and share your passion for Apple products. Learn about the
latest technology, and enhance your skills. And meet with old and new
friends over supper. Visitors welcome.

Submitting your article
Electronic submissions are preferred (to save wear and tear on my
fingers). Just choose whatever format suits and send it to:
editor@appleusers.co.nz
One page is roughly 450 words. Most article are less than 4 pages, but
longer articles may be accepted if of particular interest or relevance.
Please ask in advance if you are planning a longer article.
Please write clearly; short sentences are recommended to help you do
this. Use a spell-checker. If you are quoting some other article, please
include an acknowledgment of your source.
Pictures can help explain your article, so by all means include one (or
more) if appropriate. The format is not important - jpeg, tiff and gif are
all fine, but try to provide a high quality image (300 dpi) if possible.

Next Deadline: 12 August 2016
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PDF File Size
Have you noticed that after you have carefully prepared a letter / report /
newsletter, and loaded it with vibrant images, the PDF file is rather large?
When it is too big to email, you are faced with a choice - either remove
some images, or edit all the images to make them smaller. Or perhaps
you can break the file up into multiple parts and email them separately?
There is an alternative - you can reduce the size
of the PDF file. Open the fie in Preview (doubleclicking is usually sufficient unless you have
Adobe Reader installed), and in the File menu,
select ‘Export’ (not ‘Export as PDF’).
From this window, you are going to export the
PDF as another PDF, but after Preview has done
a little magic. At the foot of the window is the magic wand:
The Quartz Filters are various
sets of parameters that tell
Preview (and some other
programs) how to wave their wands. One
of these sets of parameters is “Reduce
File Size”. This will cause the file
exported by Preview to be smaller than
the original file, mainly by reducing the
image size and quality. - this is OK if you
will view it on a screen,but possibly not if
you are going to print the file.
Sometimes the filter does “too good a job”,particularly if you already had
a low resolution image in your document,and you think it would be nice
to be able to adjust the filter parameters a little. Yes, you can - but. you
need the magician’s assistant: ColorSync Utility.
Start ColorSync Utility (in your Utilities folder), and then open the PDF
file (File menu, and Open) that you want to “adjust”. (You may want to
make a copy of the file first - to avoid any mistakes.) At the bottom left
of the ColorSync window is a listbox labelled ‘Filter:’. Click to open
that, and you will see the same filters that
you saw in Preview. There may be additional
filters visible here, as you can have private
filters that Preview doesn’t see (the bottom 3
here). When you select the filter, its effect is
immediately visible, so you can see if that is
what you want. (ColorSync does only show
you the first page of your document, so this
isn’t as useful as it could be.) Just select
another filter, or None, to remove the first
filter, and try another.
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When you have a satisfactory result, click ‘Apply’ (in the bottom right of
the window). You can then select some other effect and go through the
same procedure - thus applying several different filter effects to your file
at once. Save the file when you are satisfied with the result.
So far this is only marginally better than using Preview, as you can apply
several filters; but what you really want is to adjust an existing filter, or
to create your own filter. For this, select “Live Update from Filter
Inspector”from the Filter listbox. This will open the Inspector in a
separate window, with the Filters function selected, and all your filters
listed.
The grey triangles on
the left are ordinary
open/close controls, in
in the image to the
right, I have opened
the “Reduce File
Size” filter,and its 2
subsections. You can
see the parameters
you can change to
affect how the filter
will effect your PDF
file.
The triangle on the
right provides actions:
Duplicate, lock/
unlock, and other
parameter subsections that you can include in your filter. Either duplicate

an existing filter, or create your own (+/- at the bottom of the window)
and see what the changes do to your document.(Remember to select the
new filter in the PDF Filter listbox.)
If you really like the effect, you can save the filter (make sure that you
specified a unique name in the Inspector - that is the name shown in the
listbox). It will be saved as a private filter (in <user>/Library/Filters/)
and will be available next time you use ColorSync Utility.
To use your new filter in Preview, you must copy it to:
<boot-disk>/Library/Filters/
(You may need to create this folder, and enter your admin password.)
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OS X & iOS Updates
In early June, Apple previewed this year’s software updates, due for
release in about September. The public beta releases are now available.
In the meantime the world goes on, and Apple continues to release small
updates to fix serious bugs and security “situations.
First were the operating systems: El Capitan 10.11.5, iOS 9.3.2, tvOS
9.2.1 and watchOS 2.2.1. These contained few user-visible functions but
numerous bug-fixes. Critically, there were among them literally scores of
security improvements, making these updates essential for all users. Note
that Security Update 2016-003 was also released, with separate versions
for Yosemite and Mavericks.
More easily visible was the iTunes update to version 12.4. This brought
back the sidebar as a component of the default window layout — a very
popular reversion indeed. Some minor changes polish up the menus.
Finally, there were 'stability improvements and bug fixes' to some of
Apple's productivity applications — Pages 5.6.2, Numbers 3.6.2,
Keynote 6.6.2, and GarageBand 10.1.2 (which received also 'multiple
enhancements to Accessibility').
On another front, while Apple hasn’t supported 32-bit Macs since 2011
when Mac OS X 10.7 Lion was released, Microsoft has continued to
release 32-bit Office software for the Mac. Five years later, Microsoft is
finally making a 64-bit build of the productivity suite available, but only
to Office Insiders for the time being. If you want to try out 64-bit Office
for Mac, you need to be an Office Insider. If you already are, you’ll have
the option to update to 64-bit; if not, you’ll need enroll through
AutoUpdate, which you can find by going to Help -> Check for Updates.
And for those of us “out there”, NASA has released a free Apple TV app.
This version joins the app’s other versions available for iOS in iPhone
and iPad versions. The NASA app has been downloaded more than 17
million times across all platforms.
The NASA app for Apple TV offers several features for users:
• Watch live streaming NASA TV, and get a real-time view of the Earth
from the International Space Station
• View more than 15,000 images individually or as a slideshow
• Play on demand NASA videos
• Find the next opportunity to view the International Space Station and
other NASA satellites pass overhead, based on your location.
• Display 2-D and 3-D satellite tracking maps
• Discover the latest NASA mission information
• Listen to Third Rock internet streaming radio
• View the Earth as Art image gallery
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Sophos Home for OS X
Unfortunately, with the growing Apple user base, we are
starting to see some attention from the undesirable
elements of the internet,and soon we may want to
consider some third-party protection in addition to that
built into our OS.
You may well be aware of 'Sophos Antivirus for Mac
(Home Edition)' — a simplified free version of the wellreputed (and complex/expensive) Sophos application designed for largescale enterprise environments.
A new version of this application, now named 'Sophos Home' was
recently released — still free. The publisher states: "The same antivirus,
malware protection, and web filtering technology trusted by hundreds of
thousands of businesses is now yours to take home."
The user interface has been simplified to better suit the intended ‘home
user’ profile, and there are some new features. The core function is of
course virus protection, which is automatic and is said to "protect you in
real time from malware and zero day attacks".
A key function of the new version is the ability to monitor and change
security settings for a whole family (up to ten Macs and PCs) from any
browser.
Web filtering is new and comprehensive. The access table lists subject
types in categories of General Interest, Social Networking & Computing,
and Adult & Potentially Inappropriate. Access to each of the defined 28
subject types can be set to Allow, Warn, or Block.
Sophos Home being free, its publisher does not offer individual support;
however, the Help system has been improved and a user support forum is
implemented.
For more information and to download/install Sophos Home, go to:
<https://www.sophos.com/en-us/lp/sophos- home.aspx>.
Installing this download will automatically remove the earlier version, if
it is found.

~~~~
Apparently, malware from China, Russia, Romania and elsewhere
is ...well, malware. But malware from the FBI isn’t ... because:
“We’re the good guys”!
Yeah, Right!
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Special offers
Peter Fitchett
Note: These specials are available to all user group members. Contact Peter (web@appleusers.co.nz) for access or coupon codes.
Eltima Software Multimedia products: 20% Discount
This offer is valid through August 31, 2016.
Nisus Writer Pro: 25% Discount
This offer is valid through July 31, 2016.
EverWeb by RAGE Software: 50% Discount
This offer is valid through December 31, 2016.
Take Control Books: 30% Discount on all eBooks
This offer is on-going.
Opus ][ Complete Collection: 25% Discount
This offer is on-going.
Joe On Tech Guides: 20% Discount on All Books
This offer is on-going.
AgileBits 1Password 5 and more: 25% Discount
This offer is on-going.
Eltima Software multimedia products: 20% Discount
This offer is on-going.
TechTool Pro: 20% Discount
This offer is on-going.
Noteboom Tutorials: 33% Off Annual Memberships
This offer is on-going.
O’Reilly: 40-50% Discount
This offer is on-going.
Prosoft Engineering: 25% Off
This offer is on-going while supplies last.
Que Publishing Products: 35-45% Discount
This offer is on-going.
SlideShark iPad PowerPoint Viewer: Free App plus Offer
This offer is on-going.

Note: These specials are available to all user group members. Contact Peter (web@appleusers.co.nz) for access or coupon codes.
page 8 Applebyte

Safari Reader
Have you ever been reading a longish article in Safari,
and wished you could get rid of all the ads and other
distractions? Well you can, and Apple has recently
refined the mechanism by which you can do it. The
Reader View is a function of Safari in both OS X and
iOS, that will perform the trick for you.
Not all web pages make use of Reader — that's up to the author. If you
come across one that does, Safari in OS X displays at the left hand end of
the Smart Search bar a small icon comprising a number of horizontal
lines. (The Smart Search bar is where the page's address is displayed.)
Click this icon and you'll be taken to a different view of the page that
strips out the advertisements and other extraneous items, leaving you
with just the text and required graphics — very much easier on the eye.
With the latest change to this feature you can tailor the Reader view even
closer to your taste. At the right hand end of the Smart Search bar, click
the icon with two A's to open a small panel in which you can choose a
font, make the text larger or smaller and/or set the background colour.
Click outside the panel to close it.
When you're finished with Reader view, click the 'lines' icon again or
press the Escape key to exit.
On an iOS device, a message 'Reader View Available' is displayed as a
suitable page is loading. Should you miss this first chance to respond to
the message, swipe down to make the Smart Search bar visible again,
and tap the 'lines' icon as for OS X. Proceed to set font, size and
background colour in the same way. Tap outside the panel to return to
Reader view, and when done, tap again on the 'lines' icon to return to the
standard view.

Trashed Files
Have you ever tried to open a file that was located in the Trash?
Chances are you’ve seen the prompt which asks you to move the file out
of the trash first.
To quickly view the contents of files in your trash, without restoring
them select the file and press the SPACE bar. If the file is able to be
displayed by QuickLook you will see its contents.
NOTE: You will still need to move it out of the trash if you want
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iOS Live Photos
The iPhone 6s introduced a new photo trick — the Live
Photo. When a photo is taken in this mode, the saved
file actually contains two items: a JPEG still image that
is displayed normally in most photo viewers, and a
short MOV movie (about 2 seconds).
For various reasons you may feel the need to extract the MOV from a
Live Photo imported into the OS X Photos application. This is actually
not at all difficult, but it is a little obscure. It might seem that Apple
didn't envisage anyone wanting to do this; they should know better.
A Live Photo imported into OS X Photos shows a small Live Photo icon
(concentric circles) in the lower left corner of a full preview image, with
a text label 'LIVE' alongside. The icon appears also if you request photo
information (Windows > Info). If you hover over the LIVE label when
viewing the full photo, you'll see the associated movie.
Still, none of this provides any indication that a MOV file exists within
the Live Photo. The Info panel just says the photo is a JPEG, and if you
export (File > Export > Export (X) Photo(s), only a JPEG is exported.
It's only if you Option-drag a Live Photo into the Finder, or select File >
Export > Export Unmodified Original for (x) Photo(s), that both the
unmodified JPEG and the associated MOV will be separately retrieved.
Another method is to use our 'old favourite' the Image Capture
application on a Mac connected to the iPhone via USB. Open Image
Capture, select the iPhone, choose 'Live Photos images', and then import
them. This will transfer both the JPEG and MOV for each image.
The iCloud Photos application lacks even the ability to view a Live
Photo, let alone separate the MOV from one; however, it does retain both
JPEG and MOV components and will sync them among iOS and OS X

Use Both Eyes
Warning: Looking at your smartphone while lying in bed at night could
wreak havoc on your vision. Make sure to use both eyes when looking at
your smartphone screen in the dark.
In the New England Journal of Medicine, doctors detailed the cases of
the two women, ages 22 and 40, who experienced ‘transient smartphone
blindness’ for months.
Apparently, both women typically looked at their smartphones with only
one eye while resting on their side in bed in the dark – their other eye
was covered by the pillow. Problem solved - Use Both Eyes!
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107 Best Mac Games
I wouldn’t dare claim to decide which game was better than another, but
Macworld is prepared to jump in and put their neck on he line with this
compilation of currently available games - including a description/
review, the price,and a link to where you can get it. I am also not going
to (re)publish it all - it would take too many pages (although that has its
attractions!). So just the introduction from Macworld,so that you have an
idea of what you are getting into, and then you can chase the link and
read the original pages...
Contrary to popular belief, Mac gamers have plenty of top games titles to
choose from these days - indeed, the most difficult part is narrowing
down the options from all the high-quality games on offer, and then
finding the money to buy and time to play them.
We can't help with the latter, but the first problem is right up our alley.
We've collected the 107 best Mac games for your delectation, dividing
them for the sake of convenience into seven categories:
Best role-playing games for Mac
http://www.macworld.co.uk/feature/mac-software/best-macgames-3484158/?p=1
Best sports and racing games for Mac
http://www.macworld.co.uk/feature/mac-software/best-macgames-3484158/?p=2
Best strategy games for Mac
http://www.macworld.co.uk/feature/mac-software/best-macgames-3484158/?p=3
Best action games for Mac
http://www.macworld.co.uk/feature/mac-software/best-macgames-3484158/?p=4
Best adventure games for Mac
http://www.macworld.co.uk/feature/mac-software/best-macgames-3484158/?p=5
Best casual games for Mac
http://www.macworld.co.uk/feature/mac-software/best-macgames-3484158/?p=6
Best puzzle games for Mac
http://www.macworld.co.uk/feature/mac-software/best-macgames-3484158/?p=7
Good luck!
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Dropbox
Dropbox enhances its productivity tools
Dropbox just dumped a ton of new productivity
features on users of its file storage and collaboration
service that are all aimed at making it easier for people
to get work done within its applications.
Updates to the Dropbox app for iOS allow users to scan documents
directly into the cloud storage service, and get started with creating
Microsoft Office files from that app as well. The company also increased
the ease and security of sharing files through Dropbox, and made it
easier to preview and comment on files shared through the service.
These launches mean that Dropbox will be more valuable to people as a
productivity service, and not just a folder to hold files. It’s especially
important as the company tries to capture the interest of business users,
who see a wide variety of competing storage services.
Users of Dropbox’s iOS app will see a big plus button that they can tap
to add content to Dropbox from their phone. To help with that, Dropbox
is adding support for scanning documents with the iPhone camera, and
saving them as PDFs. The scanning feature lets users upload multipage
documents, and gives them the ability to adjust the settings of each scan
so that uploaded documents are at their most readable.
Users can also upload photos from their phone using a new photo upload
workflow that will let them add individual images and also all of the
pictures taken on a particular day. The service will use machine learning
to try and recognize when documents are the subject of uploaded photos
and offer to convert and process them to scans.
Dropbox Business customers will be able to search for text inside those
scanned documents, thanks to new optical character recognition
functionality that the company made available for its top tier of paying
customers. It builds on full-text search capabilities that Dropbox already
has available for digital documents uploaded to its service.
Using the plus button, people can
also start Microsoft Office documents
from the Dropbox iOS app. First,
users select the document type, where
they want to save it, and give it a file
name, all inside the Dropbox app.
After that, they’ll be sent out to one
of Microsoft’s mobile apps to edit the
file they just created, with all the
changes being saved back to
Dropbox.
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People who want to use Dropbox to share files will have an easier time
doing so. The Dropbox apps for Mac and Windows now let users access
detailed file sharing settings from the Mac Finder (or Windows
Explorer). That means users can set granular permissions for sharing
documents without having to use the Dropbox web interface.
On top of that, all users can now share single files with specific people,
rather than having to provide open access to everyone with a link or
giving a list of people specific access to a folder. Users of Dropbox’s free
tier will also be able to share folders in read-only mode, something that
was previously only available to paying customers.
After sharing files, users will now be able to comment on specific parts
of a file from their Web
browser. Previously,
Dropbox comments
weren’t able to
reference a specific part
of a file—now users can
highlight an area and
discuss it in particular.
In the future, Dropbox
will also allow users to
attach Dropbox
comments to Office
files within Microsoft’s
desktop productivity
apps. It’s planning an
update to the Dropbox
badge that will let people make live comments on a PowerPoint
presentation that show up in Dropbox, without having to leave the file
they’re working on.
Dropbox also gave business users a new security-focused feature.
Dropbox Business administrators can now access a new audit log, which
provides a record of everyone who interacted with a particular file.
Those logs can be viewed through an online administrator console, but
are also accessible through the company’s API.
That means companies can choose to work with partners like Splunk and
Domo to monitor those audit logs and generate notifications if something
weird is going on.
The news comes a week after Drew Houston, the company’s co-founder
and CEO, revealed at a conference that Dropbox is operating cash flow
positive. It’s a positive sign for the company, which hasn’t been much for
announcing new, shipping features over the past year. These
announcements may signal a change for the company going forward—
it’ll be interesting to see what comes next.
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Automate Your Browser
One of the most under-appreciated tools on your Mac is Automator. It
can take a while to get the hang of, but once you have an idea of how to
use it, you can automate all kinds of useful tasks, from cleaning folders
to creating voice commands. One of my personal favorite ways to use
Automator is with its browser commands, which can help you save a lot
of time with regular actions in Safari or any other browser.
We’ll take a look at some ways you can use Automator with your
browser.
Open a Webpage at a Specific Time
For this, we’ll need to create
a Calendar Alarm. Open up
Automator and fire up a new
project, then select
Calendar Alarm.
Now, select Internet from
the left sidebar and drag the
Get Specified URLs action
to the workflow on the right.
Remove the default URL and
add the page that you’d like
to open (in this example,
we’ve used http://
www.makeuseof.com/).
This will get the correct URL into the
workflow, and now we’ll need to do
something with it. Drag the Display
Webpages action into the workflow and
place it below the previous action. You’ll

see that one produces output and
the other takes input, so they’re
connected.
When you save the project,
Calendar will open with a new
event (in this case, it’s called
“Display MakeUseOf”). You
can now edit the event so that it
repeats whenever you want it to.
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In the example above, MakeUseOf will open every Tuesday at 08:38.
Just make the changes here so your page displays at your preferred days
and times.
Open a Specific Set of Webpages
Maybe you use the same pages every morning, but you don’t want to
have them open manually. Why not create a small application that opens
them all in your default web browser?
This time, you’ll want to select Application as the document type when
you open a new project. Again, go to Internet and drag Get Specified
URLs into the workflow, then add your links:

Next add the Display Webpages action below the previous one, and
you’re set. Give the application a name when you save it; then when you
launch it, your default browser opens all four URLs in different tabs.
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Download All Images on a Page
This automation will be created as a workflow, which means you need to
run it from within Automator; even though it might seem like it would
take a long time, this can be a great way to get things done.
L e t ’s c r e a t e a n e w
workflow; open a new
document and select the
Workflow option:
Again, go to the Internet
category; this time, add Get
Current Webpage from
Safari to the workflow
(unfortunately, this means
this workflow will only
work with Safari but ...).
Add Get Image URLs from
Webpage below that.

case, the Downloads folder).

Set the Get URLS of
images dropdown to
linked from these
webpages, and add
the Download URLs
action to the
workflow. Set the
download location to
wherever you’d like
the images to
download to (in this

Now, to download all of the images from a specific page in Safari, you
just need to open that page in Safari and run the workflow from
Automator.
What Could You Automate?
It’s a bit esoteric at first, but Automator can be a hugely useful tool for
making your Mac more efficient. It takes a while to get used to the app,
but after spending some time with it, you should be able to create all
sorts of useful workflows, services, and apps for helping you do the
things you need to accomplish every day.
Why not try something yourself, and share your results at a meeting?
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Movie Time
What do you say to a free movie for a bit of entertainment? Here are a
few sites that you may find something to fill the spare moments
http://free-classic-movies.com
Reportedly the LARGEST PRIVATELY OWNED website in the world,
with 4 terabytes of movie files, all shared freely with every visitor worldwide. The classic movies are organised by date, from 1897 (L'auberge
ensorcelée (The Bewitched Inn)) to 1979 (Concrete Cowboys). There are
quite a few that I have never heard of before (but that wouldn’t be hard),
however, this is somewhere to bookmark and revisit - some of the titles
look quite interesting.
For each movie, the release date is shown (where known) along with the
title, the movie type, and the leading actors, so searching is as easy as
doing a find in the web page. There are also a few Star biographies, and
fan pick-lists if you are stuck for a choice.
You are free to watch them on your computer screen, or download them
for watching offline (either large format, or podcast sized).
https://archive.org
Internet Archive is a non-profit library of millions of free books (10
million text files), movies (2.6 million videos), software (141 thousand),
music (3 million audio files and 166 thousand concerts), websites (491
billion web pages in the WayBackMachine), and more.
In the movies,films and videos section, this library contains digital
movies uploaded by Archive users which range from classic full-length
films, to daily alternative news broadcasts, to cartoons and concerts.
Many of these videos are available for free download.
The library is probably lacking a little in organisation - but then, you are
probably going to find some unexpected gems while you are hunting
around. I’m not sure why Sci-Fi and Horrors are grouped together in one
sub-collection!
https://www.youtube.com/results?search_query=Full+Public
+Domain+Movies
Yes, YouTube now also has full public domain movies available. The
usual YouTube organisation means that if you know what you want, you
have a change of finding it, and then you have all their suggestions of
what to watch next to distract you.
Enjoy.
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Unlocking Mac (Sierra)
You will be able to unlock your Mac using your Apple Watch once the
next Mac OS is installed. macOS will ‘recognise’ your watch and
automatically bypass the login screen to enable you to start work
immediately. But can someone gain access by faking your presence?
Craig Federighi, Apple’s senior VP of Software Engineering, doesn’t
think so ...
It’s a continuation of the work we did with continuity to develop
really low-power BTLE based discovery protocols so that your
devices could discover each other continuously with acceptable
overhead from a battery point of view. And also, all the
authentication mechanisms we put in place as far as having your
devices know that they’re your devices. So that’s kind of a
foundation.
The unique challenge with auto-unlock is that you don’t want a kind
of relay-attack, where Phil is actually far away from his office and
someone basically has a bluetooth listener that will forward a signal
to you, because you’re now by his Mac, and this Mac is having a
conversation with Phil’s watch over a very long distance. And so,
we’re actually able to do time of flight calculations using peer-to-peer
Wi-Fi where we literally can measure how long at the speed of light
it’s taking for the signal to travel from your Mac to your watch and
back.
And because of that, if you interposed any kind of relay, it would
introduce a delay that would immediately tell us that there are hijinks
afoot. So that piece is critical.
Now measuring the difference between the WiFi signal being returned
from say 1 meter away, compared with 5 meters away is rather fancy,
I’m sure that you have to admit. (That is about 27 nano-seconds.)
On a similar topic:
I see that the Mac can also use use your iPhone’s Apply Pay to make
purchases.I’m just wondering whether I can sucker someone to link their
iPhone to my computer to demonstrate something quite innocent, and
then make a purchase when they are not paying attention ... sort of an
early Christmas present, you could say :-)
The more that we enable machines to link together and help each other
out, the more there will be “unintended consequences”. I suspect that we
will have some “interesting times” ahead.
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APFS
Among the tidbits Apple revealed to its developer audience at the
recently completed Worldwide Developers Conference was a new file
system for the whole range of its products (from the Mac to the Apple
Watch). Dubbed “APFS” (an acronym that Apple doesn’t completely
spell out even in its developer documentation), the file system is meant
to replace the 1998 HFS+, the file system that in turn replaced 1985’s
HFS (Hierarchical File System). (At least we knew what that acronym
stood for!)
Changing the default file system for an operating system is a big deal,
since the file system is responsible for keeping track of all of the data on
the device. But what does such a change mean for users?
Firstly, Finder is not a File System; it merely presents a view of your
files and folders for your use. The real file system, or file systems - yes,
there can be many - is hidden from your normal gaze. Probably the only
time that you need to know about the file system is when you select
which file system to use when you format a disk (a hard disk, a SSD, a
memory stick, etc) in Disk Utility.
The file system works behind the scenes, providing information to the
Finder and to applications about the files and directories that are stored
in some fashion on a device connected to your Mac — whether in
magnetic fields recorded on a spinning platter or charged cells in a solidstate device. The file system keeps track of how much storage capacity
files take up on the device, where on the device the data that make up the
files are stored, and all sorts of metadata about those files, such as their
names, when they were created and last changed, which users are
allowed to open them, and a great deal of other stuff.
APFS is designed to understand nearly all of the same instructions and
information requests that the Finder, or any other Mac application, issues
regarding storage devices managed by HFS+. You’ll still be able to move
files, rename files, copy files, open files, delete files, tag files, and so on
just as you always did.
But You Will Notice Some Differences
APFS provides built-in support for large data volumes, encryption, flash
drives, and virtual memory - developments that were bolted onto HFS+
as the technology developed.

Things that you may notice include:
Faster file copying and saving: Saving files and duplicating them on
the same device will happen much more quickly and without using as
much space. That’s because APFS has been designed to reduce data
duplication by sharing data between files as necessary. When you copy a
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file to another folder in APFS, no data is moved. Instead the copy points
to the original file’s data on the device. If one of those copies is later
changed, only the changes are stored: APFS handles which bits belong to
which files. APFS’s capability to change only parts of files also speeds
up file saving, and, especially, automatic saving using versions. Viewing
and restoring from a previous version in an app should be faster too.
al, but on a spinning disk, file fragmentation reduces performance by
forcing the read/write heads to seek more in order to access the widely
separate parts of the file. On a spinning disk, the shared data approach
will mean more disk fragmentation.
But fragmentation on an SSD does not affect speed nearly as much. On
an SSD, rewriting memory cells is much more costly, both in terms of
speed and in terms of the cells’ usable life: rewriting SSD cells gradually
wears them out. Writing just the changed file contents, and doing so in
scattered physical locations on an SSD, is an efficient way to increase
wear-leveling as well as to reduce the number of write operations. That’s
a win-win now that most Apple devices, including Macs, rely on flash
storage.
However, APFS is designed to work with spinning disk drives as well
and should be smart enough to take disk location and rotational latency
into account when choosing locations to store file changes on such
devices.
Snappier backups and restores: APFS can create read-only snapshots
of a volume’s file contents. Once again, this capability comes courtesy of
the shared data approach. Since file changes are scattered in different
locations on a device, APFS can keep track of the data locations that
comprise a file at any given time and make sure they are preserved. New
versions of Time Machine, as well as other backup utilities, should be
able to take advantage of APFS snapshots, making incremental backups
that much more snappy.
Flexible partitions: APFS creates physical containers on a device,
which can then be subdivided, or partitioned, into individual storage
volumes. Unlike the partitions managed by HFS+, APFS partitions share
their space with each other within the same container. This means that if
you have a 500 GB APFS container, you can create multiple volumes
within it that each will show up in the Finder as having 500 GB
capacities. As a consequence, the amount of free space shown for each
volume reflects the free space available in the container, not the
individual volumes.
Although this approach could lead to user confusion, it might be
mitigated by one other APFS feature: fast directory sizing. Under APFS
you will no longer have to wait for seconds or even minutes while the
Finder shows you the exact amount of storage used by a folder in a Get
Info window. Fast directory sizing makes that information much more
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quickly available — useful if you want to know if your photo library will
fit on the portable drive you’re bringing on your vacation.
More encryption options: macOS Sierra, like versions of OS X since
10.7 Lion, offers full disk encryption via FileVault 2. Similarly, although
this isn’t obvious to the user, iOS has offered individual file encryption
since iOS 4 and has encrypted all user files created by third-party apps
since iOS 7. APFS provides both full-volume and individual file
encryption: you can use full volume encryption on one volume in an
APFS container and use individual file encryption on another volume in
the same container.
In addition, APFS provides not only single-key file encryption but multikey encryption, allowing a file’s data and its metadata to be encrypted
separately. For example, you could have a volume that allowed a file
cataloging utility to decrypt metadata about a file, such as its name and
creation date, but not to decrypt the actual file contents.
Regardless, although it’s difficult to know how Apple and other
developers will take advantage of these capabilities, it’s safe to say that
you’ll have more encryption options available to you when APFS is in
charge of your device storage. Plus, since Apple built encryption into
APFS, encryption should be snappy.

Transition to APFS
Apple intends the transition to be as painless as possible. When you buy
a new Mac once APFS is the default file system, you should have no
transition hassle at all: Setup Assistant should move your data from your
old Mac to the new one pretty much as it has all along. And, since
macOS will continue to support HFS+ as well as APFS (just as it
supports other file systems), you’ll be able to mount and use older HFS
+-formatted external drives with no problems.
Apple also plans to provide an in-place APFS migration utility for users
who upgrade older Macs to a macOS version that uses APFS as its
default. Most likely, the migration process will take some time (minutes
or hours) to convert an existing HFS+ device to APFS, but Apple’s goal
is to make the process as simple and as safe as possible.
And remember, Apple’s aim is that APFS will be the default file system
by the end of next year - not so far away!

Historic note
Apple has previously attempted to replace HFS+; the most notable being
development of a version of ZFS, a combined file system and logical
volume manager designed by Sun Microsystems. There were reported to
be legal issues involving the use of this software, and the development
was abandoned (much to the dismay of some rather enthusiastic fans).
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Around, About

Peter Fitchett
New Disks
Seagate has announces 3 new hard disks, so if you are running a bit short
of disk space, there new 10TB (that is TeraBytes,or 10,000GB). That
should be big enough for a while. One reader commenting on the
announcement wonders how much disk you would need to back that up?
My best guess would be another 10TB, but my bigger concern would be
how long it would take to do the backup, particularly using USB 2 that
many of our slightly older Macs still use - probably about 100 hours, or 4
days. (USB3 is about 10 times faster).
Western Digital is expected to announce a similar sized disk
‘shortly’.Their current maximum is 8TB.
Old Technology
Rumour has it that Apple will abandon the 3.5mm headphone jack on the
next iPhone model. (Support for headphones over its Lightning cable
was introduced in 2014, but of course, you can’t charge your phone if
using headphones.) More than 300,000 people have signed a petition
urging Apple not to ditch the headphone socket. I’m sure that a small
adapter will become available for those who really want to keep their old
headphones - but 30000 is a pretty small market to design a product for.
Remember back to 1999 when Apple removed the floppy disk drive from
your Mac? Sony – a pioneer of the floppy disk – has announced it was
killing off the storage device.
And the world is still turning!
Legal
When the Chinese company, Shenzhen Baili Marketing Services Co.,
took on Apple in December 2014, telling Chinese regulators that the
Cupertino, Calif., company’s new models infringed on its smartphone
design patents, it had bold aspirations, a big-name investor in Chinese
internet giant Baidu Inc. and a team of experienced executives. By the
time regulators reached a decision this year (against Apple!), the
company had collapsed, brought down by buggy products,
mismanagement and fierce competition, according to former employees
and investors. (The company has been absent from China’s mobilephone market for at least a year.) Former employees said the lawsuit with
Apple was always more a marketing ploy than a serious court case, so
what now? Apple is appealing.
Meanwhile on the home front, Florida resident Thomas S. Ross has filed
a lawsuit against Apple recently, claiming that the iPhone, iPad, and iPod
infringe upon his 1992 invention of a hand-drawn ‘Electronic Reading
Device’ (ERD). The patent application was declared abandoned in April
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1995 by the U.S. Patent and Trademark Office after he failed to pay the
required application fees!
While the plaintiff claims that he continues to experience ‘great and
irreparable injury that cannot fully be compensated or measured in
money,’ he has demanded a jury trial and is seeking restitution no less
than $10 billion and a royalty of up to 1.5% on Apple’s worldwide sales
of infringing devices.
Yes, that would cause me a few sleepless nights as well!
Incompetent?
Since the ‘release’ of the developer and public beta versions of the nest
macOS, Sierra, there has be an almost endless parade of reports of
‘Hidden’ features discovered in the software. All I can think is that Apple
must be totally incompetent for so many feature that it went to the
trouble to hide, have been so readily found. And by reporters, even!
Come on folk, just because Apple didn’t hi-light it for you in keynote
speech, or hand feed you with prepared press releases for a pre-view
version of their software, it does not mean that the features are hidden.
What else?
What else can I complain about? I think that is enough for now - the rest
of the space is for you to start writing something for the next Applebyte.

SeniorNet Mac
Computer Training Lessons: Two-hour sessions, once a week for four
weeks. Course notes are provided. Classes are small with a maximum of
six students and two tutors per lesson.
Social Events: Held on the fourth Tuesday of the month.
Newsletter: Supplied every two months.
We are now located at: 190 Worcester Str, Christchurch.
Contact: If you would like to join SeniorNet Mac and are in the 55-plus
age group, please contact Allan Rutherford at (03) 352-4950, or email:
ajmr@xtra.co.nz,
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About the user group
Aims

Canterbury Apple Users is a non-profit
subsection of SeniorNet Mac
(Christchurch) that exists for the purpose
of exchanging ideas and expertise about
the use of Apple computers, the Macintosh
operating systems, and related hardware
and software.

Meeting venue
Meetings are held on the last
Wednesday of each month
(except December) beginning at
7:30pm, at the Convention
Centre, corner Highsted and
Sawyers Arms Roads.
Drinks, and maybe a snack, are
available while we all calm
down after the excitement of the
meeting.
If you find it difficult to get to
meetings, please contact an
organizer to see how we can
help.

Group contacts
Website

http://www.appleusers.co.nz

Mailing Lists

Peter Fitchett
listadmin@appleusers.co.nz

(3) 960 8189

The HELP email list is open to all Mac users who
wish to give or receive assistance. See our website
for instruction on how to subscribe/unsubscribe.

